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Objective

This example demonstrates the use of the multi-frequency scan (MFS) for PSoC® 4 CapSense® applications to prevent false
touch detection in the presence of external noise. This code example demonstrates this feature for both CSD (self-capacitance)
and CSX (mutual-capacitance) designs.

Requirements

Tool: PSoC Creator™ 4.2, PSoC Programmer, and Bridge Control Panel
Programming Language: C (Arm® GCC 5.4.1)

Associated Parts: PSoC 4100S Plus

Related Hardware: CY8CKIT-149 PSoC 4100S Plus Prototyping Kit

Overview

This example demonstrates the use of the multi-frequency scan feature of CapSense for PSoC 4 devices. It demonstrates this
feature for both CSD (self-capacitance) and CSX (mutual-capacitance) designs.

The code scans all the buttons and sliders on the CY8CKIT-149 and drives the LEDs depending on the button and slider touch
status.

The code also sends the CapSense raw data over an I2C interface to the on-board KitProg, which in turn enables reading the
data from CapSense Tuner GUI or Bridge Control Panel. The CapSense Tuner and Bridge control Panel are used to observe
the changes when the multi-frequency scan feature is enabled.

This document details the following:

1. The use of the multi-frequency-scan feature to prevent false touch detection in the presence of external noise at a particular
frequency.

2. The effects of multi-frequency scan such as scanning at three different sense clock frequencies and increased scan time.

3. A method to test the improvement in touch detection accuracy brought in by MFS, by manually injecting external noise and
showcasing that there is no false touch detected when the MFS feature is enabled.

Pre-requisite
The user of this code example is assumed to be familiar with CapSense technology and basic terms such as raw counts,
baseline, and difference counts. If you are new to CapSense, see the application note AN85951 — PSoC® 4 and PSoC 6 MCU

CapSense® Design Guide and the code example CE220891 — CapSense with Breathing LED (In PSoC Creator, select File >
Code example > Device family > PSoC 4100S Plus).

Hardware Setup

This code example uses the kits default configuration. Refer to the kit user guide to ensure that the kit is configured correctly.

Software Setup

Ensure that you have all the software tools as mentioned in Requirements section installed.

WWW.CYpress.com Document Number: 002-27719 Rev. ** 1


http://www.cypress.com/
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/documentation/application-notes/an85951-psoc-4-and-psoc-6-mcu-capsense-design-guide
https://www.cypress.com/documentation/application-notes/an85951-psoc-4-and-psoc-6-mcu-capsense-design-guide
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-149-psoc-4100s-plus-prototyping-kit

&2 CYPRESS

EMBEDDED IN TOMORROW™ CapSense with Multi-Frequency Scan

When to Use Multi-Frequency Scan?

Multi-frequency scan (MFS) is used to prevent false touch detection in the presence of external noise at a particular frequency.

If MFS is disabled, whenever there is an external noise at the same frequency as the sense clock or a harmonic of the sense
clock frequency (in case of CSD), or Tx clock frequency (in case of CSX), raw counts may fluctuate from scan to scan and this
may cause the sensor to false-trigger.

When MFS is enabled, each sensor is scanned three times, at three different frequencies called channels. For each sensor, the
CapSense component calculates three raw counts and baselines, one for each of these channels, and then calculates the
difference-count between each raw count and baseline pair. Finally, a touch is detected on a sensor, based on the median
difference-count amongst the three channels of that sensor. This prevents false touch detection if there is noise at the same
frequency or harmonic of one of the channels; raw counts produced by other two channels are minimally affected by noise.

Points to Consider While Using MFS

1. The sensor is scanned three times, each time with a different sense clock frequency (for CSD) or Tx clock frequency (for
CSX). The base channel (zero channel) is the nominal frequency as configured in the Component, the second and the third
channel frequencies are chosen by the Component at run time. These could be any of the following pairs: +5% and +10%
or —5% and +5% or —5% and —10%. The second and third channel frequencies are generated by varying the IMO frequency
of the device.

2. Because each sensor is scanned three times, the scan time of each sensor becomes three times compared to the case if
MFS is disabled. Figure 1 shows the scan time when the MFS feature is disabled; Figure 2 shows the scan time when the
MFS feature is enabled.

3. Enabling this feature increases the RAM and flash usage. See the Component datasheet for more information on memory
usage when multi-frequency scan feature is enabled.

4. The CapSense_IsBusy () API will return CapSense_SW_STS_BUSY. This means that the previous scanning is not
completed, and the hardware block is busy until the Component completes the scan at all the three frequencies. This implies
that the scan time has increased.

5.  When other filters such as IIR filter and average filter are used, these filters are applied on each channel; therefore, the
memory usage and the processing time will be three times to the case when MFS is not enabled.

6. SmartSense™ and the MFS feature cannot be used together. They are mutually exclusive features.

Component-Specific Considerations

1. If MFS is enabled, the current CapSense Component (v6.0 and earlier) changes the IMO clock frequency during each
sensor scan. All components which use IMO for critical time-dependent operations such as SysTick, CapSense gestures,
and asynchronous communication such as UART should be taken care.

Note: It is also possible to change the sense clock frequency without modifying the IMO clock by changing the sense clock
divider. This ensures that time-critical operations are not affected by MFS. However, this is a custom technique and doesn’t
provide as good noise immunity as the IMO modification method. Contact Cypress technical support for support on this
method.

2. If MFS is enabled, the current CapSense Component (v6.0 and earlier) sets the CSX Tx Clock frequency to fixed 300 kHz
in third-generation devices and to 1 MHz in fourth-generation CapSense devices. See the ‘CapSense Selector Guide’
section in AN64846 — Getting Started with CapSense to know the CapSense generation present in each PSoC device.

Note: Because the Tx clock frequency is fixed, ensure that the Tx and Rx electrode’s parasitic capacitance is charged and
discharged completely with this Tx clock frequency. See the “CapSense Performance Tuning (CSX Sensing Method)”
section in AN85951 — PSoC® 4 and PSoC 6 MCU CapSense® Design Guide for information on dependence of Tx Clock
frequency on sensor parasitic capacitance.
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Figure 1. Scan Time when Multi-frequency Scan Is Disabled

Configure 'CapSense' ? X
|7 Load configuration | Save configuration ] Export Register Map
Name: |Cap Sense
W Gestures | Builtin q b
General CSD Settings CSX Settings  Widget Detal\l Scan Crder I
Sense/Tx Scan resolution (bits) /| Slot scan time
Sean slot Sensor assignment Mode clock {kHz) | Number of sub-conversions| {ps)
0 BTNO_Rx0 CSX 1000 50 50
1 BTN1_Rx0 CSX 1000 40 40
2 BTNZ_Rx0 CSX 1000 40 40
3 LinearSliderl_Sns0 CSD 6000 12 a5
4 LinearSliderl_Sns1 CSD 6000 12 a5
5] LinearSliderl_Sns2 CSD 6000 12 a5
6 LinearSlider)_Sns3 CsD 6000 12 a5
7 LinearSlider)_Sns4 CsD 6000 12 a5
8 LinearSlider)_Sns5 CsD 6000 12 85
I Total scan time: 642 ps.
d
Datasheet Apply Cancel

Figure 2. Scan Time when Multi-frequency Scan is Enabled

Configure 'CapSense’ ? X
[ Load configuration |g Save configuration |#] Export Register Map
Mame: ‘CapSense
" Basic " Advanced | Gestures | Builtin 4p
General CSD Settings CSX Settings  Widget Details I Scan Order I
Sense/Tx Scan resolution (bits) /| Slot scan time
Scan slot Sensor assignment Mode clock fkHz) | Mumber of subconversions (s}
0 BTNO_RxD CSX 1000 50 150
1 BTN1_RxD CSX 1000 40 120
2 BTN2_Rxl C5X 1000 40 120
3 LinearSlider)_Sns0 csD 6000 12 256
4 LinearSlider)_Sns1 csD 6000 12 256
5 LinearSlider)_Sns2 csh 6000 12 256
& LinearSlider)_Sns3 csh 6000 12 256
7 LinearSliderd_Sns4 CSD 6000 12 256
8 LinearSliderd_Sns5 CSD 6000 12 256
I Total scan time: 2 ms
|
Datashest Apphy Cancel

Operation

Testing the Basic Operation

1
2
3
4.
5
6
7

Power the PSoC 4100S Plus device by plugging a USB 2.0 Type A to Micro-B Cable on J8 (USB Micro-B connector).
Build the code example by selecting Build > Build CE227719_CapSense_with_Multi_frequency_scan in PSoC Creator.
Push the SWD Select switch (SW4) to the PSoC position to program the PSoC 4100S Plus device.

Program the PSoC 4100S Plus device (select Debug > Program).

Touch the CapSense buttons and observe that the corresponding LEDs turn ON.

Slide your finger over the CapSense linear slider and observe that the LEDs turn ON up to the position of touch.

To monitor CapSense raw data using the Sense Tuner GUI, launch the tuner by right-clicking on the CapSense Component
and choose Launch Tuner from the drop-down menu as shown in Figure 3.
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Figure 3. Launch Tuner GUI
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8. A new window called “Sense Tuner” appears on the screen. Open the Tuner Communication Setup dialog by selecting
Tools > Tuner Communication Setup in the menu, or clicking the Tuner Communication Setup icon.

9. Select the appropriate 12C communication device and set the following parameters as shown in Figure 4.

Figure 4. Tuner Communication Setup Parameters

Tuner Communication Setup ? x
Ports: Port Corfiguration
KitProg2/08200A09B031F7400 - 12C 12C address: (8
KitProg2/08200A9B031F7400 - SPI Sub-address: | 2-Bytes ~
Intel(R) Active Management Technology... Power
KitProg2 USB-UART (COM26) - UART 1. Use Mechanical VDD Switch to

Select the Power Source.
2. Select Digttal Source i Kit has it.

Port Information 18 ~ | Volts
KitProg3 version expecting 1.07, but found
KitProg2 version 1.05. Please use PSoC O ON ® OFF

Programmer G| to upgrade fimware.
12C Speed
O 1MHz (@ 400kHz
(O 100kHz () 50kHz

10. Click Connect to establish connection.

11. Click Start to start data streaming from the device. The Tuner GUI displays data from the sensor in the widget view and
Graph view tabs. See the “CapSense Tuner” section in CapSense Component datasheet for detailed information on Tuner
GUL.

12. Observe from the Widget/ Sensor parameters section in the Sense Tuner window that the CapSense Component calculates
three different modulator IDAC values for each of the channels as shown in Figure 5 and Figure 6.
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Figure 5. Three Different MOD IDAC Values for the CSX Button
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Figure 6. Three Different Modulation IDAC Values for the CSD Slider Widget
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Note: If compensation IDAC is enabled, the three different compensation IDAC values can be observed for each sensor
if CSD sensing method is used.

It can be seen from that that graph view of the Sense Tuner that the only the raw count and baselines for Channel 0 are displayed
as shown in Figure 7. The Tuner displays the difference count graph after applying the median filter. You can use the Bridge
Control Panel tool to monitor the raw counts and baseline for all the three channels, as the next section Using Bridge Control
Panel to Monitor Raw Counts and Baselines explains.
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Figure 7 Graph View of Sense Tuner
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Using Bridge Control Panel to Monitor Raw Counts and Baselines

) Asynchronized
@® Synchronized

The Bridge Control Panel is a data monitoring and logging tool that is automatically installed along with the PSoC Programmer.
If you are unable to find this tool installed on your PC, install the latest PSoC Programmer version.

Refer to the following steps to use Bridge Control Panel to monitor raw counts and baselines of all channels:

1. Create a register map file for the CapSense configuration by clicking on the Export Register Map option in the Configure
‘CapSense’ window as shown in Figure 8.

Figure 8. Export Register Map Option in CapSense Configuration Window

Configure ‘CapSense’ ? x
(5 Load configuration |5 Save configuration I |#] Export Register Mapl
Name:  [CapSense
Basic | Advanced | Gestures | Built-in 4p

4 Moveup & Movedown 3¢ Delete

CSD tuning mode: | Manual tuning

Type | Name Sensing mode Sensing elements) Finger capacitance
O [BTND CSX (Mutual-cap) 1 Fix 1 Tx N/A
O |BTMI CSX (Mutualcap) 1 Fix 1 Tx N/A
O |BTHZ CSX (Mutualcap) 1 Fix 1 Tx N/A
52 | LinearSiderd CSD (Sefcap) 6 Segments N/A
+
Sensor resources
CSD electrodes: 6  CSXelectrodes: 6  Pinsrequired: 13 Pins available: 54
m— rosty o

2. Power the CY8CKIT-149 PSoC 4100S Plus Prototyping Kit by plugging a USB 2.0 Type A to Micro-B Cable on J8 (USB
Micro-B connector).

Open the BCP tool (choose Start > All Programs > Cypress > Bridge Control Panel > Bridge Control Panel).
4. Inthe BCP tool, select the CY8CKIT-149 12C-USB bridge port in Connected 12C /SPI/RX8 Ports: window and set 12C as

its protocol, as Figure 9 shows.
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Figure 9. Bridge Control Panel - Port and Protocol Selection
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5. Select Charts > Variable Settings and provide the variable names for each parameter (raw counts and baselines for each
channel) as shown in Figure 10 and click OK to exit.

Figure 10. Variable Settings in BCP

i_'f!-"]l Variable Settings — *
Variables  Flags
N Active  Varable Name  Type Sign  Scale Offset Color 2

Rawd lngint [] 1 0 Black

2 Raw1 long int a 1 o Blue

3 Raw2 long int a 1 o Lime

4 Bsin0 long int a 1 o Red

5 Bsin1 long int a 1 o BlueViolet

& Bsln2 long int a 1 o LawnGreen
7O Key7 byte a 1 0 Magerta

g O Varg byte a 1 0 Olive v
Print packet every |1 = (®) AxisXis a count Auto Range of AxsY

Ery

Seroll |0 < (O AxisXis atime Min 0 Max | 500

Load... Save... X Cancel

6. Do the following to read the raw counts and baselines for the three channels of BTN1 as illustrated in Figure 12:

a. Choose File > Open File and select the CE227719_CapSense_with_Multi_Frequency_Scan - Commands.iic file
supplied with the project and click Open. Alternatively, go to Editor and type or copy the following command:

W 08 00 7A R 08 @GORaw0 @1Raw0 @QORawl @1lRawl @ORaw2 @lRaw2 @0Bsln0O @1BslnO @O0Bslnl @1Bslnl
@0Bsln2 @1Bsln2 p

The offset (00 7A) in the above command is entered based on the register map file generated in stepl. Figure 11 shows
the parameters referred from the register map file (register offset for raw0 = 122 (007A in hexadecimal).
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Figure 11. Offset of BTNO's Raw Count from Register Map File

BTN1_RX0_RAW

The sensor raw counts.

Register/struct name Type Offset Size
BTN1_RX0_RAWO uint16 122 2
BTN1_RX0_RAW1 uint16 124 2
BTN1_RX0_RAW2 uint16 126 2

b. Place the cursor on the command line and then click Repeat.
c. Observe the data packets in the output window.

7. To view the sensor data in a graphical format, click on the Chart tab. Figure 13 shows the raw counts and baselines for the
three channels.

Figure 12. Reading CapSense Sensor Data in Bridge Control Panel
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Figure 13. Chart Showing Three Different Raw Counts and Baselines
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Noise Injection to Test Effectiveness of MFS

This section explains how to inject extreme external noise into the system and show the effectiveness of MFS in reducing false
triggers caused by noise injection.

1. Inject a square wave of 1 MHz (same as Tx Clock frequency) with an amplitude of 1 V into the system at the Rx pin of BTN1
(Pin 4.5 in J2 header) using a function generator as shown in Figure 14.

Figure 14. Test Circuit to Inject External Noise into the System Using Function Generator

Function
generator

1 MHz

Note: The amplitude of the noise can be varied by changing the voltage output of the function generator.

2. When the MFS feature is not enabled, the BTN1 sensor false triggers due to the induced noise. This can be seen using
Sense Tuner GUI as shown in Figure 15. You may also be able to observe this by the flickering of the corresponding LED
in the kit indicating false touch.
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Figure 15. MFS Disabled: Sensor False Triggers Due To Induced Noise
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3. Now, MFS is enabled as shown in Figure 21. The effect of noise on the three different raw counts can be seen using BCP
as shown in Figure 16. It is evident that only Channel 0 is affected by the external noise because it is closer to the noise
frequency and the effect of noise on Channel 1 and Channel 2 is minimal because they have a different frequency when
compared to the noise frequency.

Figure 16. F Enabled: Effect of Extreme Noise on Different Channels
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4. Touch the sensors to see of the effectiveness of MFS feature. It is clearly seen from the Tuner GUI graph view that there
are no false triggers due to the induced noise as shown in Figure 17. The sensor responds well to finger touch.
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Figure 17. MFS Enabled: No Sensor False Triggers Due to Induced Noise
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5. ltis seen from Figure 18 that channel 1 and channel 2 responds well to touch and only channel 0 is affected by the induced

noise.
Figure 18. No False Triggering when MFS |Is Enabled
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Design and Implementation

This code example has a single workspace — CE227719 CapSense_with_Multi_Frequency_Scan.

Figure 19 shows the PSoC Creator schematics for the “CE227719_CapSense_with_Multi_Frequency_Scan” code example.
This code example uses CapSense, SCB (configured as EZI2C Slave), Pin, and Clock.

Figure 19 . PSoC Creator Schematics for CapSense Linear Slider, Buttons, and LEDs

CE227719 CapSense with Multi Frequency Scan

CapSense Linear Slider and Buttons 12C for tuning CapSense
Sensing
CapSensa %

f@—= CapSense Onboard Fope
TS USB-12C Bridge | ¢
f— Shave

CapSense Key Configuration: EZIZ2C configuration:

1. Three CSX buttons - Data Rate : 400 kbps

2. One CSD Linear slider with six segments - Number of addresses: 1

3. CED Tuning Mode: Manual Tuning - Primary slave address: 0x08

4. Multi Frequency Scdn enablied - Sub-address size: 16 bit

Event Indicators

LEDs Contralled by Buttons

LED 13— -l g -loiis AN — e
820 !
Green_BF, R61 |
LED 12--------- —jJff—------ —AN— - -4
820 !
Green_KF, R0
LED 11— - oo e - oo - AN -0
820
LEDs Controlled by Slider
Green_ EF, R24 :
LED_10 ------- —J—------- —AN— - -4
820 !
Green K, R2d '
[ILED 9 --------——------- —ANY— - -4
820 '
Green KX, R23
LED 8 --------—jJ¢¢—------ —AN— - -8
820 !
Graen BF, R21 '
LED. 7 --------—J—------- —AN— - -4
820
Groen_ &R, R20
LED:§: ol il gttt .
820 }
Green P, R19 1
m) ]

The CapSense Component is configured with one linear slider widget with six segments and three button widgets. This code
example uses the CapSense Sigma-Delta (CSD) sensing method for sliders and Mutual Capacitive Sensing (CSX) sensing
method for buttons. Both mutual and self capacitance have their own advantages. To understand the detailed comparison
between them, refer to the application note, AN85951 — PSoC® 4 and PSoC 6 MCU CapSense® Design Guide. When the
CapSense linear slider is touched, the LEDs turns ON to indicate the position of touch. When a touch is detected on CapSense
buttons, the corresponding LEDs turn ON.

The code example is designed for the PSoC 4100S Plus device and associated CY8CKIT-149 PSoC 4100S Plus Prototyping
Kit. Table 1 shows the pin assignment of the PSoC Creator Components.
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Table 1. Pin Assignment for the CE227719 CapSense with Multi-frequency Scan Code Example

Pin name CY8CKIT-149 PSoC 4100S Plus
\Capsense:CintA\ P4[2]
\Capsense:CintB\ P4[3]
\Capsense:Cmod\ (Cmod) P4[1]

\CapSense:Rx[0]\ (BTNO_Rx0) P4[6]

\CapSense:Rx[1]\ (BTN1_Rx0) P4[5]

\CapSense:Rx[2]\ (BTN2_Rx0) P4[4]
\CapSense:Sns[0]\ (SLD_Sns0) P2[7]
\CapSense:Sns[1]\ (SLD _Sns1) P6[0]
\CapSense:Sns[2]\ (SLD _Sns2) | P6[1]
\CapSense:Sns[3]\ (SLD _Sns3) P6[2]
\CapSense:Sns[4]\ (SLD _Sns4) P6[4]
\CapSense:Sns[5]\ (SLD _Sns5) | P6[5]

\CapSense:Tx\ (BTNO_TXx) PO[2]
\EZI2C:scl\ P3[0]
\EZI2C:sda\ P3[1]
LED1 P3[4]
LED5 P1[0]
LED6 P1[2]
LED7 P1[4]
LEDS8 P1[6]
LED9 P2[0]
LED10 P2[2]
LED11 P5[2]
LED12 P5[5]
LED13 P5[7]
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Table 2 lists the PSoC Creator Components used in this example, how they are used in the design, and the non-default
settings required so they function as intended.

Table 2. List of PSoC Creator Components in the CapSense with Multi-Frequency Scan Code Example

CapSense CapSense v6.0 One CSD

EZI2C Slave (SCB mode) | EZI2C v4.0 One Serial Communication Block (SCB) and two GPIOs

Digital Output Pin LED_1 v2.20 110
LED 5 v2.20 110
LED_6 v2.20 110
LED_7 v2.20 110
LED_8 v2.20 110
LED_9 v2.20 110
LED_10 v2.20 110
LED_11 v2.20 110
LED_12 v2.20 110
LED_13 v2.20 110

For more information on the hardware resources used by a Component, refer to the respective Component datasheets.

Parameter Settings

CapSense Component
Figure 20 through Figure 27 show the settings for the CapSense Component.

Figure 20. CapSense Component - Basic Tab

Configure 'CapSense’ ? *
[ Load configuration [g] Save configuration m Export Register Map

Name: |CapSense |
Basic | Advanced | Gestures | Builtn | b
4 Moveup ¥ Movedown 3¢ Delete CSD tuning mode: |Ma'1uaihrhg V|
Type Name Sensing mode Sensing element(s) Finger capacitance
O [BTND CSX (Mutual-cap) 1 Rx 1 Tx N/A
O |BTN1 CSX (Mutual-cap) 1 Rx 1 Tx N/A
QO [BTNZ CSX (Mutualcap) 1 Rx 1 Tx N/A
= LinearSliderl CSD (Seffcap) [ Segments N/A
_i_

Sensor resources
CSD electrodes: & C5X electrodes: 6 Pins required: 13 Pins available: 34
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Figure 21. Enable Multi-Frequency Scan in General Settings of Advanced Tab

Configure 'CapSense’ ? X
|5 Load configuration [ Save configuration | %] Export Register Map.

MName ‘CapSense |
@ Advanced | Gestures | Builtin 4 b
General CSD Settings CSX Settings  Widget Details  Scan Order
Regular widget raw court fiter type Baseline IR fiter settings
[] Enable IIR fiter (First arder) Regular widget baseline coefficient:
R filter raw count coefficient 128 Proximity widget baseline coefficient: |1

[] Enable median fiter (3-sample)
[] Enable average fiter (4-sample) [ Enable sensor autoresst

Enable seftest libra
Enable multifrequency scan

o W[ owes

Figure 22. CSD Settings in Advanced Tab

Configure 'CapSense’ ? x
(-5 Load configuration gl Save configuration Iﬂ Export Register Map

Name: |Cap5ense
@ Advanced | Gestures | Builtsin 4
General CSD Seftings  CSX Settings  Widget Details  Scan Order
Scan settings [] Enable shield slectrode

Modulator clock frequency {kkHz):
43000

e My (472 Enable the shield electrode for reliable operation
Sense clock source: Auto w in the presence of water droplets

] Enable common sense clock

Sense clock frequency (kHz): | Set per widget
Inactive sensor connection: Ground ~
IDALC sensing corfiguration: IDAC sourcing v

I Enable IDAC auto-calibration I
[] Enable compensation IDAC

Datashest Apply Cancel
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Figure 23. CSX Settings in Advanced Tab

Configure 'CapSense’ ? *
[ Load configuration | Save configuration |#] Export Register Map
Mame: |CapSense
Mvanoed ]/Gesmres }/Built-in ] 14k
General CSD Settings Widget Details Scan Order

Scan settings

Modulator clock frequency (kHz):
43000

Actual frequency (kHz):

Tx clock source: Auto -
|| Enable common Tx clock
T: f <Hz Set per widget
N/AF no touchpad

Enable IDAC auto-calibration

savpes | [ coes

Figure 24. CapSense Component BTNO CSX Settings

Configure 'CapSense’ ? X
[ Load configuration |l Save configuration Q] Export Register Map
Name: |CapSen5e
Mvanoed ]/Gesmres ]/Built-in ] q b
General CSD Settings CSX Settings  VWidget Details  Scan Order
Widget./Sensor list: Widget/Sensor parameters:
| Widget Hardware Parameters:
Tx clock frequency (kHz) 1000
Actual Tx clock frequency kHz) 1000
Mumber of sub-conversions 50
| Widget Thresheld Parameters

Finger threshold 100
Moise threshold 50
Megative noise threshold 50
Low baseline resst 30
Hysteresis 12

LinearSlider]_5Sns0 ON debounce 3

LinearSlider]_Sns1

LinearSlider)_Sns2

LinearSlider)_5ns3 Tx clock frequency (kHz)

LinearSlider)_Sns4 Sets the Tx clock frequency for the CSX widget.

LinearSlider)_Sns5

e o[ oes
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Figure 25. CapSense Component BTN1 CSX Settings

Configure 'CapSense’ ? X

5 Load configuration g Save configuration ﬂ Export Register Map

Name: |CapSense

Muranoell ]/Gesh_wes ]/Built-in ] 9k

General (CSD Seftings CS5X Settings VWidget Details  Scan Order

Widget/Sensor list: Widget/Sensor parameters:
=2 BTND(CSX) | Widget Hardware Parameters
BTMO_Rx0 Tw clock frequency (kHz) 1000
Actual Tx clock frequency (kHz) 1000
Number of sub-conversions 40
~ Widget Threshold Parameters
Finger threshold 100
MNoise threshold 60
Negative noise threshold 60
- Low baseline reset 30
=38 LinearSliderd (CSD) Hysteresis 0
; LinearSlider0_Sns0 ON debounce 3
LinearSliderl_Sns1
LinearSliderd_Snz2
LinearSliderd_Sns3 Tx clock frequency (kHz)
LinearSliderl_Snsd Sets the Tx clock frequency for the CSX widget.
LinearSliderl_Sns5

ot o[ owes

Figure 26. CapSense Component BTN2 CSX Settings

Configure 'CapSense' ? X

(5 Load configuration g Save configuration Iﬂ Export Register Map

MName: |Cap5ense
Muranoell ]/Gesiwes ]/Built-in ] 4Pk
General CSD Settings CSX Settings  Widget Detals  Scan Order
Widget/Sensor list: Widget/Sensor parameters:
-0 BTND(CSX) v | Widget Hardware Parameters
. BTHNO_Rx0 Tx clock frequency (kHz) 1000
BTNO_Tx Actual Tx clock frequency (kHz) 1000

B O BTN (C5X) Number of sub-conversions 40

BTN1_Rx0 ~ | Widget Threshold Parameters
Finger threshold 160
Moise threshold 80
BTNZ_R Negative noise threshold 80
i BTNZ_Tx Low baseline reset 30
=38 LinearSliderd (CSD) Hysteresis 16
o LinearSlider0_Sns0 ON debounce 3
LinearSliderD_Sns1
LinearSlider0_Sns2
LinearSlider0_Sns3 Tx clock frequency (kHz)
LinearSlider0_Snsd Sets the Tx clock frequency for the C5X widget.

LinearSlider0_Sns5

ot o [ o
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Figure 27. CapSense Component LinearSlider0O CSD Settings

Configure ‘CapSense’ ? X
(5 Load configuration [l Save configuration |#] Export Register Map

Name:  [CapSense
" Basic)/” Advanced | Gestures | Builtin 4
General (CSD Settings  CSX Settings  Widget Detals | Scan Order
Widget/Sensor st Widget/Sensor parameters
=) BUTTOND (C5X) ~ Widget General Parameters
- BUTTONO_Rx0 Diplexing False
BUTTOND_Rx1 Maximum position 100
BUTTOND_Rx2 v Widgel Hardware Paramelers
BUTTONO Te Sense dlock frequency (kHz) 5000
ERJ] LinearSiicerd (CSD) Actual sense clock frequency cHz) 6000
LinearSiderd)_Sns0 Scan resolution 12bts
LinearSiderd_Sns1 Modulator IDAC Auto-calbrated
LinearSiderd_Sns2 v Widget Threshold Parameters
LinearSiderd)_Sns3 Fingerthreshold 49
LinearSiderd_Snsd Noise threshold 24
LinearSiderd_Sns5 Negative noise threshold 24
Low baseline reset El}
Hysteresis 3
ON debounce 3
v Position Filter Parameters
Meciian fiter False
IR fiter False
IR fiter coefficient 128
Adaptive IR fiter False
Average fiter False
Jtterfiter False
v Adaptive IIR Filter Parameters
Fostion movement threshold 3
Fostion slow movement threshold 7
Fostion fast movement threshold 12
IR coefficient maximum mt 60
IR coefficient minimum imit 1
IR coefficient divisor 64

Diplexing
Enables usage of specific duplexing sensor pattem to double
the slider physical touch sensing area.

Datashest Apply Cancel

12C Component
Figure 28 shows the settings for the EZI2C Component.

Figure 28. EZI2C Slave Component’s Basic Tab

Configure 'EZI2C' ? >

Name:

Configuration *” EZI2C Basic | EZI2C Pins | Builtn | 4b

I Data rate (kbps): |4JD’D ~ | I Actual data rate kbps): 400
Clock from teminal

Clock stretching

|| Byte mode

MNumber of addresses 1 ~

Primary slave address (7-bits):

Sub-address size (bits): 16 ~

LI Enable wakeup from Deep Sleep Mode

- o
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Reusing This Example

The multi-frequency scan feature is available in CapSense Component versions v3.1 and above. This feature is supported in all
CapSense-enabled devices in the PSoC 4 family of devices, including:

= Third-generation CapSense: PSoC 4000, PSoC 4100, PSoC 4200, PSoC 4100M, PSoC 4200M, PSoC 4200L, PSoC
4100 BLE and PSoC 4200 BLE.

= Fourth-generation CapSense: PSoC 4000S, PSoC 4100S PSoC 4100 S Plus and PSoC Analog Coprocessor.

The tuning parameters must be changed in accordance with the kit used and sensor properties. See the PSoC 4 and PSoC
CapSense Design Guide for more information on CapSense sensor tuning.

Related Documents

Application Notes

AN85951 PSoC 4 and PSoC 6 MCU Describes how to design capacitive touch sensing applications with PSoC 4 and
CapSense Design Guide PSoC 6 MCU
AN79953 Getting Started with PSoC 4 Introduces the PSoC 4 device and explains how to build a PSoC Creator project

PSoC Creator Component Datasheets

CapSense Supports various interfaces such as Button, Matrix Buttons, Slider, Touchpad, and
Proximity Sensor

EZI2C Slave Supports one or two address decoding with independent memory buffers

Pins Supports connection of hardware resources to physical pins.

12C Supports 12C Slave, Master, Multi-Master, and Multi-Master-Slave configurations

Device Documentation

PSoC 4100S Plus Datasheet PSoC 4100S Plus Architecture Technical Reference Manuals
PSoC 4100S Plus Register Technical Reference Manuals

Development Kit (DVK) Documentation

CY8CKIT-149 PSoC 4100S Plus Prototyping Kit
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